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MMI CellScan

1 Installation

The MMI system may only be installed by an MMI service engineer or our des-
ignated representative in the laboratory of the customer. After the installation
training will be provided in the use and operation of the system. The customer
should not change the installation of the equipment.

Should you want to move an installed unit, please contact MMI for assistance.
With any malfunction of the device, please contact our service department:

service@molecular-machines.com

After installation or modification of the MMI system, an authorized specialist
must perform a thorough check to ensure that the system is in perfect condi-
tion. If your system comprises a laser, it must be ensured that the laser safety
features are functioning correctly and that the covers to protect against laser
radiation are fitted.

1
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2 The mmi CellTools
instrumentation family

The mmi CellTools are a fully modular instrumentation family, including the
following components:

• mmi CellCut : laser microdissection to isolate single cells or areas of
tissue

• mmi CellManipulator : optical tweezers to manipulate cells or beads with
an optical trap

• mmi CellEctor : automated micro-pipetting to mechanically manipulate
cells or beads with a capillary and mechanical micromanipulator

• mmi CellScan: whole slide imaging scanner to create and store full res-
olution whole slides images (WSI)

• mmi CellViewer : mmi CellViewer is a stand alone software package to
view and annotate whole slide images created with mmi CellScan.

• mmi CellDetector : machine learning software for biological image anal-
ysis. mmi CellDetector is available in two flavours

– detect objects on whole slide images (WSI)

– detect objects on the live image

Any or all of these modules can be combined in one microscopic environment.
The mmi CellDetector WSI and also be used with the stand alone program
mmi CellViewer

3
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3 mmi CellTools – Main
application

3.1 Main window and plug-ins

Fig. 3.1 shows the extended tool area and explains the main components of
the mmi CellTools user interface.

Figure 3.1: Structure of the mmi CellTools user interface

The major portion of the window is occupied by the live video panel, which
displays the current field of view of the microscope and serves as the main
area for interaction between the user and the system.

mmi CellTools is a single piece of software that controls all micromanipulation
devices of the mmi instrumentation family (see chapter 2). The instrument-
specific controls are located in the application panel. Switch between appli-
cations using the tabs at the top.

Those user interface controls that are common to all applications are located

5
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in the tool bar at the top of the window. The user database controls provide
access to instrument parameters for specific samples, for certain imaging sit-
uations, and for each objective (see section 3.2). The remaining common
tools on the tool bar provide elements for camera and stage control.

On systems equipped with an automated microscope, the microscope panel
provides access to z-drive (focus) control and other microscope-specific fea-
tures (see chapter 5). The slide overview panel provides controls for slide
scanning and navigation (see section 3.4.4). Finally, the status messages
bar at the bottom displays current stage coordinates and camera frame rate.

CellTools offers three user interface styles.

• gray

• dark

• classic

The dark style is optimized for fluorescence and light sensitive applications.
To switch between styles select:

Project →Style

Figure 3.2: Classic (left) and dark (right) style

To accommodate for left-handed users, the application and microscope panels
can be moved to the left-hand side using the menu item

Setup →Left-handed UI

Whenever you see a warning sign at a specific function. Place the mouse over
the sign and a text box appears with a description.

3.2 User-specific database

All settings saved in the mmi CellTools are unique to the current user logged
in. mmi CellTools fully supports Microsoft Windows user management. During
program startup the last settings saved by the active user are loaded.

The database represents a hierarchical structure:

6
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User =⇒ Channel 1 =⇒ Objective 1
=⇒ Objective 2

...
=⇒ Channel 2 =⇒ Objective 1

=⇒ Objective 2
...

...

Basically the user can save all optical parameters separately.

The Setup represents all necessary parameters to define an illumination meth-
od (bright field, fluorescence, DIC. . . ). If you change a parameter in a setup,
the change will only be reflected for the current user.

The Objective represents all objective related settings and calibrations. If you
change an objective calibration or objective related parameter, the change only
will be reflected for the current setup and user.

3.2.1 Channel editor

To open the Channel editor press the edit button next to the selected channel.

The channel selection box contains the defined parameters for each imaging
channel. You can add or remove a channel and all corresponding parameters
can be edited.

Figure 3.3: channel editor

If you run different types of experiments, e.g., microdissection with bright field,
microdissection with fluorescence, or optical tweezers it is recommended to
define one channel for each of these experiments.

To rename the defined channels click on the channel name and type in a
different name.

3.2.1.1 Channel options

• the filter, condenser, optical path, stitch and multi channel imaging
settings are only used with motorized microscopes. The use of these

7
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parameters is explained in sections 5.2, 4.7.6 and 3.3.6.

• if a supported external fluorescence excitation filter wheel is mounted,
emission filter wheel settings show up addtionally.

• if a supported LED light source with selectable wavelenghts is mounted
the channel can be selected by the drop down list FL Channel.

• if your system is equipped with more than one camera, different chan-
nels can be associated with a certain camera using the drop down list
Camera. You can then switch to a specific camera by selecting a chan-
nel defined for that camera. The camera used should also be reflected
in the channel name.

The camera associated with a channel is displayed in the Channel editor (col-
umn Camera).

Channels are orginzed in synchronisation groups. If two channels are in the
same group, calibrations will apply not only to the currently active channel, but
to all channels in the same synchronisation group.

It is highly recommended to use dedicated synchronisation groups
for different cameras.

3.2.1.2 Preview channel

One channel can be selected as a preview channel. The preview channel is
used during the automatic sample detection (foreground detection) scan, see
chapter 4.7.1. To be able to run a fast automatic sample detection you have to
select a channel using short camera exposure times, p. ex. brightfield.

3.2.2 Objective editor

To open the Objective editor press the edit button next to the selected objec-
tive.

The objective selection box contains all objectives defined for the active chan-
nel. You can add and remove an objective and edit all corresponding param-
eters. If you create a new channel, all objectives will automatically be copied.

To rename the defined objective click on the objective name and type in a
different name.

The nosepiece position and lamp voltage settings are only used with motor-
ized microscopes.

8
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Figure 3.4: Objective editor

If specified, nominal magnification will be used to compute various objective-
dependent properties.

The X and Y [pixel/mm] values define the field of view and are dependant
of the used objective and camera. These values are calculated automatically
with

Setup→Align camera with stage

(see section 3.7.2).

In addition to the parameters displayed in the Objective Editor window, the
following information is stored separately for each objective:

• Camera settings (see section 3.3.2)

• Camera alignment (see section 3.7.2)

• Lens offset (see section 3.7.3)

• Z-Focus lens offset (for automated microscopes only, see section 5.4.3)

• if a supported LED light source with controlable light intensities is mounted,
the intensity can be selected by the parameter FL intensity[%].

If one of these settings is not correct, please refer to the corresponding chap-
ter.

3.2.2.1 Preview objective

One objective can be selected as a preview objective. The preview objective
is used during the automatic sample detection (foreground detection) scan,
see chapter 4.7.1. To be able to run a fast automatic sample detection you
have to select an objective with low magnifictaion, p. ex. 4x.

9
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3.2.3 Default database reconstruction

Each user handles his/her own database. Changes in this user-specific data-
base will not be visible for any other user.

A default database is always stored separately. This default database is spe-
cific for your instrument and will be set up and handled only during installation
and service.

If for some reason, a user’s database becomes unusable, the user can recover
the default database as follows:

Setup →Restore factory settings

The default database will automatically be recovered and is directly visible in
mmi CellTools.

You will lose all slide, setup and group data contained in the
user database.

3.3 Camera operation

mmi CellTools supports a range of scientific digital cameras, supplied by MMI
or third parties:

• The mmi CellCamera range of digital cameras for general microscopy
applications

– DXA285cf

– MXF285cf

– VCXU23c

– VCXU50m

• Hamatsu

– Fusion

– Fusion BT

– Orca Flash IV

• Andor iXon

10
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3.3.1 Multiple cameras

mmi CellTools also supports multiple cameras. If more than one camera is
connected to the system, switch between the cameras by selecting a channel
dedicated to that camera.

To define the camera used by a channel, open the Channel editor and click on
the camera field. A drop down list shows up, in which you simply select the
camera related to that channel.

Do not use the Channel editor to switch between cameras. The
Channel editor is only used once to create (at least) one channel
for each camera. Then, change cameras by selecting the corre-
sponding channel. Use different synchroisation groups for differ-
ent camera channels, so that camera alignments (section 3.7.2),
parfocal correction (section 5.4.3) and paraxial corrections (sec-
tion 3.7.3) only have to be calibrated once for every objective.

3.3.2 Camera settings

For best imaging results the camera can be controlled through a settings win-
dow (Fig. 3.5). To open it, click the camera button in the toolbar (Ctrl + R).

Figure 3.5: Camera settings for mmi CellCamera models

Image exposure is controlled through the top elements in the dialog. Unless
Automatic exposure is selected, the exposure time can be controlled through
the Exposure time slider or the adjacent input field. In Automatic exposure
mode the slider is inaccessible. If the auto-exposed images are too bright or
too dark, use the Exposure correction slider to compensate.

11
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The hardware camera amplifier Gain can be adjusted to receive brighter im-
ages. With high gain the images become noisier. For elder CCD cameras
(DXA285cf, MXF285cf) this effect is much more intense than with newer CMOS
cameras (VCXU23c, VCXU50m). Higher gain settings will, however, reduce
the required exposure time. For high quality images (e.g. for publications) it is
preferable to use a longer exposure time and low gain. Note that the allowed
gain range is greater when automatic exposure is off.

The controls in the bottom part of the dialog allow control over color and con-
trast. Use the Gamma slider to control image contrast. The default Gamma
value is 0.75, and it may be adjusted over a range of 0.01 to 2.0. Low gamma
values are recommended especially to brighten low light fluorescence images.
High gamma values reduce noise and improve the black level of the image.
The black level can be uses to suppress noise, the white level to supresss
overilluminations.

The camera Mode provides color settings optimized for various applications.
For bright field, the color quality can be optimized with the Best color mode.
The camera transfers a high quality data stream with full pixel resolution. By
selecting Fast imaging mode, the image rate (frames per second, fps) will be
maximized. In this mode up to 55 fps (depending on your camera model) with
full pixel resolution are displayed. For fluorescence applications, the contrast
can be optimized with the Fluorescence option. The camera transfers a high
quality data stream with full pixel resolution. This setting is used mainly in
combination with the Gamma and Gain setting. If you select Binning, the
camera operates at a lower resolution by combining pixels, which yields in
brighter black and white images at a very high frame rate. Black and white
modes are also available for the VCXU23c camera.

Color shifts, mainly caused by changes in lamp brightness, can be corrected
using the white balance function. To set the white balance, first locate an
empty, transparent part on the sample slide, then click the Set white balance
button. If the image is too bright or too dark the white balance fails.

MMI CellTools also supports automatic shaping correction. To get a well cor-
rected image please display a gray image without any structures

• remove the sample from the stage

• select an average image brightness

• select the menu

Setup →Shading correction

• activate Correct shading in the camera control panel (Fig. 3.5)

The Set white balance option is not available for fluorescence
and monochromatic imaging modes.

12
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All camera settings, including white balance, are stored separately for each
objective. This eliminates the need to adjust the camera after each objective
change. Optionally, the software uses a single white balance setting for all
objectives. This is recommended for non-automated microscopes. Select

Setup →Save white balance per objective

to enable or disable this function.

Figure 3.6: drop down menu to reach camera related options

Additional camera related option are available in the drop down menu next to
the camera button.

3.3.3 Freeze video / live video

In fluorescence applications it makes sense to freeze the video when you have
acquired a good image. After freezing the video you can close the fluores-
cence shutter and go ahead with drawing and cutting your dissectates without
further photo bleaching of the fluorescence dye.

To freeze the video use the menu item

Freeze

of the drop down next to the camera button.

To go back to live video presentation select

Live

3.3.4 Saving images

To save an image simply press the Save image button or press Ctrl + S.

The file dialog allows you to specify the image filename and image type (JPG,
BMP, PNG and TIF). The image will be saved with maximum pixel resolution.

13
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Figure 3.7: drop down menu for same image options

By selecting the Include drawings from the drop down next to the Save image
button, you can save an image including all markers and drawings.

Press the Copy image to clipboard menu from the drop down next to the
Save image button or press Ctrl + Alt + C to make the current image available
to other applications. The image will be copied to the Windows clipboard in
order to paste it into e.g. office and image processing applications.

3.3.5 Recording movies

mmi CellTools allows you to record live camera images into video files (AVI
format). It supports compressed and lossless video codecs and allows you to
record time-lapse movies.

Figure 3.8: Movie recording functions in the tool bar

Click the Record button to start recording a new movie. CellTools will auto-
matically create a new AVI file in the movie folder and record video until you
press the Stop button. If Auto-open is enabled (see below), the movie will
open in Media Player immediately after recording. Otherwise, you can access
recorded movies through the drop-down menu items Playback (open in media
player) and Open movie folder.

By default, the movie folder is located in

My Documents\mmiCellTools\Movies.

Movies are compressed with a video codec, currently either Win-
dows Media Video 9 or XVID. To play back those movies, your
computer will require installation of the same codec. Codecs are
found on the mmi CellTools installation media.

Also note that any shapes drawn will not be recorded.

14
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3.3.5.1 Movie settings

Detailed aspects of movie recording can be controlled by opening the Movie
settings dialog (Fig. 3.9).

Figure 3.9: Movie settings

The Encoding specifies the format (codec) to store the video frames. Follow-
ing formats are available:

• Motion JPG

• FFMPEG

• XVID

To create basic time lapse movies only adjust the Time lapse factor as de-
sired. This factor defines the speed at which the movie will play back. Enter
“1x” to turn off time lapse (standard time).

The Playback rate specifies at how many frames per second the final video
should be played back. (This is identical to the recording rate unless using
time lapse.) The default playback rate is 10 Hz and should be suitable for
general use.

The Recording interval specifies the minimum time interval between two
recorded video frames. The recording interval is computed from time lapse
factor and playback rate and is for information only.

To control the rates at which frames are recorded and played back, change
the Playback frame rate. If time lapse is off, the movie is played back at the
same rate at which it was recorded. When using time lapse, the recording
rate is automatically adjusted. The dialog displays the recording interval, i.e.
the time elapsed between two frames. This interval significantly influences the
size of the resulting video file.

The Movie folder input field allows you to specify the destination folder where
movie files are saved. For maximum performance, this should not be a net-
work folder. Check the Open movie after recording option to have movies
automatically open and playback in Media Player after recording.
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3.3.6 Multichannel imaging

Figure 3.10: Brighness correction slider for multi channel images

Figure 3.11: Pseudo color for multi channel images

A multi channel image is recorded by pressing the multi channel image button
or Shift + M (only for motorized microscopes). A multi channel image consists
of several images with different camera/filter settings. For example, it can be
used to merge brightfield and fluorescence images from different fluorophores
(e.g. DAPI and GFP). The brightness of the resulting image can be adjusted
in multi channel configuration drop down, Fig. 3.10.

To enable an imaging channel for the multi-channel image select enable in the
Channel editor (see section 3.2.1). These recorded images are then merged
to one image with the selected pseudo color for each channel. The image
color can be selected or defined by custom in the pseudo color, Fig. 3.11.

• If white is selected, a original image will be merged to the multi-channel
image (see Fig. 3.12 left).

• If black is slected, the multi-channel image will exclude the image from
the selected channel (see Fig. 3.12 right).

3.3.7 Autofocus

The Autofocus can be enabled/disabled by pressing the autofocus button or
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Figure 3.12: Select white (left) and black (right) as pseudo color for brightfield image

Ctrl + F (only for motorized microscopes). With activated autofocus the mi-
croscope focus the plane with the sharpest image after each movement, au-
tomatically.

For safety reasons and speed opitmization the autofocus search range can
be limited by using the focus range option in the drop down near the focus
button.

3.4 Motorized stage control

The movement of the motorized stage is controlled by the mmi CellTools soft-
ware.

3.4.1 Mouse movement

Choose the move mode by clicking the hand tool button. Additionally, you can
quickly switch to moving mode and back again by pressing the Space bar.

In the move mode the cursor in the video panel always appears as a hand.
By clicking and dragging the left mouse button, the stage directly follows the
mouse movement.

If stage movement does not exactly follow mouse movement, you
may need to carry out the camera alignment procedure (see sec-
tion 3.7.2).

3.4.2 Keyboard movement

The main arrow keys and numeric pad arrow keys can be used to move the
stage in discrete steps or continuously at constant velocity (Fig. 3.13).

A single press of a cursor key moves the stage by a defined distance. By
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Figure 3.13: Stage movement using the keyboard

default, this is 10% of the screen for the cursor keys and 90% of the screen for
numeric pad keys.

NumLock must be turned on for numeric cursor keys to work as
expected.

For moving larger distances, hold down the respective key. The velocities for
the two sets of movement keys can be set independently (see section 3.4.3).
By default, the cursor keys move slowly and the numeric pad keys move fast.

In applications where you need movement by well-defined distances only, the
continuous movement can be suppressed by enabling Caps Lock .

3.4.3 Stage movement settings

To change stage movement settings, press the Stage movement settings
button, click the menu bar item

Stage →Movement settings

or press Ctrl + P to get the window in Fig. 3.14.

Acceleration This value determines the stage motors’ acceleration for both
keyboard and mouse movement.

Reducing this value may facilitate the handling of liquid suspension sam-
ples. For all other samples we recommend using 100%.

Units For the arrow keys on the keyboard you can set the stage settings in
two different units:

• Screens (or percentage of screen)
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Figure 3.14: Stage movement settings

• Micrometers (µm)

When using micrometer units, note that you may have to adapt distances
with every objective change.

inverted determines the movement direction using the arrow keys. By default
(unchecked) the stage moves in the direction of the arrow keys. By in-
verting the movement, the field of view is shifted in the direction of the
arrow keys.

Distance and velocity These values can be chosen independently for cursor
and numeric pad keys. By default, cursor keys are used for minor steps
and numeric pad keys for major steps.

Values that are outside the allowable range will be shown in red.

3.4.4 Overview scan

Fig. 3.15 shows an overview of your sample (the “roadmap image”).

Figure 3.15: Slide overview

The overview scan is started by pressing the Scan slides. If no area of interest
is defined, the maximal scan area will be used. The maximum scan area is:
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• the inner part of a mmi MembraneSlide

• the square around a petri dish

• the square around the cap of a single cap holder

• the square around the well of a custom grid, if only one well is defined.

• the complete slide for all other microscope slides

• the complete multiwell plate

The current field of view is indicated with a red blinking rectangle or point. You
can move this red frame by clicking and dragging the left mouse button. The
motorized stage moves automatically to the chosen detail. With this navigation
method you always see the position on the slide.

You can also move to the position of interest by double clicking into the over-
view area with the left mouse button.

Define scan areas with the Select area tool. After pressing the button you
can select areas of interest in the overview window using the mouse. Only the
areas of interest will be scanned.

Press the Delete scan region button to delete selected scan area with the left
mouse button.

Press the Delete scan regions button to delete all manually selected scan
areas. The maximal scan area will be used instead.

Begin the scan by pressing the Scan slides button. You can always interrupt
the scan with the Stop scan button. Also pressing the Esc key will interrupt
the scan.

To move from one slide to another you can directly select the target slide
button. Alternatively you can move to another slide with the keyboard arrow
keys. The slide number indicator will automatically adjust to the current slide.

You can set the name of the slide in the corresponding field (Fig. 3.15). The
slide name is used to save the scaned image.

The overview scan configuration can be setted by pressing the configuration
button in Fig. 3.16.

• Show drawings: show or hide the shapes by drawing tools (drawing tools
is described in section 3.5.1).

• Show slide name: show or hide the slide name

• Save scan tiles: all tile images during overview scan can be saved in
hard disk
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Figure 3.16: Overview scan configuration

For full resolution whole slide scanning - including options like multi slide scan-
ning, time-lapse scanning, z-stack scanning, multi-channel scans - consider
the mmi CellScan modulesee section 4.7.

3.4.4.1 Preview image

To save, load or delete the scaned preview image by simply clicking into the
overview area with the right mouse button, see Fig. 3.17.

Figure 3.17: Menu for preview image options

3.4.4.2 Pin positions

With the pin button you can save the current stage position. By clicking on the
arrow to the right you obtain the pin positions menu (Fig. 3.18).

Figure 3.18: Pin positions
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You can select a pin, which moves the stage to the respective position. The
last two entries enable you to delete either the currently selected or all pin
positions.

3.4.4.3 Analyse tiles during scan

To automatically analyse all overview scan tiles with the image analysis soft-
ware mmi CellDetector check the Analyse tiles during scan checkbox in the
Overview panel.

You need to train the mmi CellDetector before Analyse tiles dur-
ing scan will work properly, see the separeted mmi CellDetector
manual.

3.4.4.4 Shape navigation

Objects in the sample, like cell areas or cells, are displayed as shapes. These
shapes can be created manually or by using mmi CellDetector.

Once you created shapes you navigate between the shape by using

• move to first shape, Home key

• move to last shape, End key

• move to next shape, + key

• move to previous shape, - key

The keyboard keys allways navigate inside the current group, see section 4.6.
The shapes can be directly used for further .

3.4.4.5 Drawing tools and measurements

Drawing tools and distance measurements are described in section 3.5.1.

3.5 Slide viewer

The Slide viewer is a tool to display full slide images, to draw shapes around
regions of interest and to annotate them. Images acquired with the mmi
CellScan can be accessed at any magnification.

The slide viewer (Fig. 3.19) can be opened via the menu
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Setup →Stage insert (Ctrl + I)

or alternatively by the Show stage insert button in the overview panel.

Figure 3.19: The Slide viewer can be used to display full slide images, draw
contours and to configure the stage insert

The Slide viewer has following main purposes:

• display and zoom whole slide images (WSI)

• draw, display and review shapes around objects of interest

• create and manage groups of objects

• navigate through your samples, by double-clicking on the target position

• configure the geometry of the

– stage insert and

– slides or microplates, each containing the active regions called wells.

• assign a role to each well

• exporting and importing stage geometries
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3.5.1 Drawing tools

The drawing tools can be selected through the buttons above the main window.
Additionally, a quick switch between moving and drawing mode is possible by
pressing the Space key on the keyboard. As drawing tools you find from left

Figure 3.20: Drawing tools: select, freehand, circle, ellipse, rectangle, line, delete,
erase, expand and measure

to right

• select and move a shape: click on a shape and drag the shape over the
field of view. The shape will be highlighted

• freehand: use the mouse as a pencil

• circle: mark a first point of the circle and define a second point by drag-
ging the mouse. Fix diameters can be set via the drop down menu next
to the circle button

• ellipse: draw the main axis first and than define the minor axis by drag-
ging the mouse. Fix parameters can be set via the drop down menu next
to the ellipse button

• rectangle: mark the left upper corner and than define the diameter by
dragging the mouse. Fix parameters can be set via the drop down menu
next to the rectangle button

• line: mark the left upper corner and than define the length by dragging
the mouse. Fix lengths can be set via the drop down menu next to the
rectangle button

• delete: delete a shape by clicking on the shape

• erase: remove small pieces of the shape by using this tool as eraser.
The erasing size can be set via the drop down menu next to the erase
button

• expand: add small pieces to the shape by using this tool as brush. The
erasing size can be set via the drop down menu next to the expand
button

Shapes are orginised in groups (see section 4.6).
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3.5.1.1 Select and move shapes

With the select and move tool (Alt + R) you can select and activate contours
with a left mouse click. All highlighted shapes are activated. To reposition the
activated shapes, drag and drop the shapes with the cursor.

By holding down the Shift key all shapes can be repositioned simultaneously
(e.g. to compensate for a shifted sample).

3.5.1.2 Freehand

The freehand drawing tool (Alt + F ) allows you to define arbitrary shapes.
Use the left mouse button to draw the contour around the area of interest.

Figure 3.21: Freehand drawing options

CellTools normally closes the contour automatically when you release the left
mouse button. If this is not desired, you can turn it off by unchecking the tick
box “Closed shape”.

Some objects, especially those larger than the field of view, cannot be traced
with a single drawing operation. For such cases multiple segments can be
combined into a single shape. Hold the keyboard shift key when you want to
extend the shape, release the shift key to start a new freehand shape.

Procedure

1. Start outlining the object normally using the freehand tool as far as the
field of view allows.

2. Move the stage such that the end of the drawing is still visible and you
can continue drawing.

3. While holding down the Shift key, draw the second segment. (You may
release the key while drawing.) Once you have finished drawing, the two
segments will be attached.

4. Repeat steps 2–3 as necessary.

As an alternative, you can check the tick box “Extend selected shape (multi-
segment drawing)” instead of holding the Shift key. Remember to uncheck it
when you have finished with the last segment.

Multi-segment drawing may be easier when “Closed shape” is turned off (un-
checked).
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3.5.1.3 Circles

The circle tool (Alt + C) is suitable for creating circular shapes.

Figure 3.22: Circle tool

Fixed-size circles can be created by checking “Fixed diameter” and typing the
value in the corresponding input box (Fig. 3.22).

3.5.1.4 Ellipses

Certain shapes can be approximated as an ellipse. Select the ellipse tool (Alt
+ E) to draw an ellipse. Drawing an ellipse is done in two steps:

• define the major axis (longest distance)

• define the minor axis (width)

Figure 3.23: Ellipse tool

Fixed-size ellipses can be created by checking “Fixed geometry” and typing
the values in the corresponding input box (Fig. 3.23)

3.5.1.5 Lines

Cutting straight lines with the line tool (Alt + L) may be useful for ablation or
cell-surgery type experiments, as well as for cutting tests.

Fixed lines can be created by checking “Fixed length” and typing length and
angle in the input boxes. To reverse the cutting direction, enter an angle of
180◦.
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Figure 3.24: Line tool

3.5.1.6 Rectangles

The rectangle tool (Alt + Q) provides a quick method to outline objects of
interest.

Figure 3.25: Rectangle tool

Fixed-size rectangles can be created by checking “Fixed dimensions” and typ-
ing the values in the corresponding input box (Fig. 3.25).

3.5.1.7 Deleting shapes

There are several ways to remove shapes:

• Deleting arbitrary shapes using the eraser tool (Alt + Del)

• Deleting the current (highlighted) shape by pressing Del

• Using the context menu (Fig. 3.26)

• Using the group editor (section 4.6.4).

To delete all shapes, or all shapes from the current group, use the context
menu (Fig. 3.26) or use the corresponding keyboard shortcuts Ctrl + Del and
Ctrl + Shift + Del .

3.5.1.8 Copying and pasting shapes

To copy the active contour use the menu item
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Figure 3.26: Context menu, open with the right mouse button in the image panel.

CellCut →Shapes →Copy

Select

CellCut →Shapes →Insert

to insert the copied shape.

The corresponding keyboard shortcuts are Ctrl + C for Copy and Ctrl + V for
Paste.

3.5.1.9 Cloning

Cloning is a more controlled way of replicating shapes. This function is espe-
cially useful for laser ablation experiments, or when you need to collect multiple
pieces of tissue at regular distances. The clone function allows you to create
multiple copies of a shape, where copies are arranged in a rectangular grid.

To start, select the shape you would like to clone and select Clone... from the
context menu (Fig. 3.26).

Figure 3.27: Clone shapes
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The dialog allows you to specify the number of shapes per row and per col-
umn, as well as the distances between rows and columns. Depending on your
application, you may choose whether distances are measured between the
shapes’ edges or from center to center.

Click the Preview button to see the result, or click Ok to generate the clones.

Note that, on systems with an automated microscope, the system
will focus on each cloned shape using the sample plane focus
mechanism (section 5.4.2), if enabled. If clones are out of focus
when cutting, either redo the sample plane definition or disable
plane tilt focussing.

3.5.2 Text annotations

Highlighte shapes can be annotated with your comments, by using the Anno-
tate highlighted menu in the popup menu Fig. 3.26. A small popup window

Figure 3.28: Free text annotation for shapes

Fig. 3.28 will allow to enter the text you want to save with the hightlighted
shapes.

3.5.3 Hide shape indices

The popup menu shown in Fig. 3.26 or using the shortcut Ctrl + H also allows
to hide the shape indices. This can be helpfull if many shapes exists. In this
case hiding indices also accelerates the drawing.

3.5.4 Move to group

The popup menu shown in Fig. 3.26 also allows to move highlighted shapes
into another group. This allows to correct the group assignement in case you
forgot to select the correct group before drawing the shapes.
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3.5.5 Reset slides

For convienience the popup menu shown in Fig. 3.26 also allows to reset
slides. This means

• delete all focus points

• delete all scan regions

• delete all image analysis regions

• delete preview and whole slide images

3.5.6 Configure scale bar

The popup menu shown in Fig. 3.26 also allows to configure the colors and
thickens of the scalebar shown in the right lower corner of the image panel.

3.5.6.1 Navigating between shapes

There are several keyboard commands that allow you to locate your shapes
and navigate between them. These are illustrated in Fig. 3.29.

Figure 3.29: Keyboard navigation

• Home move to the first shape of the highlighted group

• End move to the last shape of the highlighted group

• + move to the next shape of the highlighted group
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• - move to the previous shape of the highlighted group

• Arrow up move a small step up

• Arrow down move a small step down

• Arrow left move a small step left

• Arrow right move a small step right

• Numpad: Up move a large step up

• Numpad: Down move a large step down

• Numpad: Left move a large step left

• Numpad: Right move a large step right

3.5.7 Distance measurement

Select the measurement tool or press Alt + M to measure distances on the
sample.

Figure 3.30: Distance measurement

Press the left mouse button and drag the mouse. After releasing the mouse
button you can see the measured distance (Fig. 3.30)

3.5.8 Slide Navigation

Using the mouse wheel you can zoom into the slide image and back. Alter-
natively you can use:

• fit to window button

• Zoom in button
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• Zoom out button

• zoom slider shown in Fig. 3.19 right of the image panel

To move the image select the shift image

3.5.9 mmiCellScan 5D channels

Figure 3.31: Control the timelapse, zStack and Multi-channels of your 5D WSI.

The mmi CellScan 5D can create multichannel whole slide images (5D WSI’s).
To navigate through the timepoints, the z-Positions and the to colorize the
different channels appropriate sliders and color selection options will be pro-
vided, see Fig. 3.31. The brightness for merged image or seperate image for
each channel can be adjusted. The selection of pseudo color, please referto
section 3.3.6

3.5.10 Shape import from third party applications

In case you ordered the Shape Import function, mmi CellTools enables you to
load shapes created in following third party applications:

• TissueGnostics StrataQuest

• Visiopharm

• Evident ScanR

32



MMI CellScan

• 3DHistech SlideViewer

• Generic csv files

The mmi Service will configure your system to select the requested vendor.

Select Import from third party scanner to select the file you want to import.
The file type matching your vendor will be preselected.

Figure 3.32: Shape import menu

3.5.10.1 TissueGnostics StrataQuest

StrataQuest can provide black and white mask files in the bigtiff format. The
regions of interest (ROI) show up as white blobs on black background.

mmi CellTools can find these ROI’s and import them as shapes into all cell
types defined in mmi CellTools. If you select a filename with the format:

FilenameGroup1.tif (p. ex. xyzEpithel.tif ....)

and mmi CellTools has following CellTypes (see section 4.6) configured:

Ephitel, Bone, Blood, Muscle

CellTools will search the folder containing xyzEpithel.tif file for following addi-
tional files:

xyzEpithel.tif xyzBone.tif xyzBlut.tif xyzMuscle.tif xyzREFERENCE.tif

from each of these files Celltools finds, it imports the shapes given as withe
dots on black background (mask), into the related group.

If mmi CellTools does not find any related cell type, it imports the ROI’s from
the selected mask file in the active (highlighted) cell type.

If CellTools finds XihangREFERENCE.tif CellTools imports (up to 3) reference
points. Having reference points the user can use the serial section functionality
to fine tune the shape positions.
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3.5.10.2 Visiopharm

Visiopharm can provide xml files containing the shape information. These
shapes will be loaded into the active (highlighted) cell type.

3.5.10.3 Evident ScanR

In Evident ScanR you can define so called gates to select different objects
types. The found objects for all gates can be exported into a text file. The mmi
CellTools will compare the gate names and the cell type names defined in mmi
CellTools. mmi CellTools will load the centers of objects into the related cell
type.

3.5.10.4 3DHistech SlideViewer

SlideViewer can export shapes into comma separeted files ("*.csv"). These
can be imported from mmi CellTools into the active (highlighted) cell type.
Shapes only having on point will be interpreted as reference point.

3.5.10.5 Generic csv files

Shapes from generic comma separeted files ("*.csv") can be imported. mmi
CellTools will load these shapes into the given cell type. If the cell type is not
defined the shape will be loaded into the active (highlighted) cell type. Shapes
only having on point will be interpreted as reference point. The generic csv
import also supports shape z coordinates and the use case (cut or meander).
Example files can be provided by MMI.

3.5.11 Slide viewer plugins

The Slide viewer is able to host plugins like mmi CellScan or mmi CellDetector
in the right side panel, see Fig. 3.33. This allow you to easily navigate through
your whole slide images or use machine learning for image analysis.

3.6 Stage inserts configuration

The slide viewer can be expanded by pressing the configuration button to
configure the stage inserts. Depending on the stage inserts configuration up
to 8 full slide images can be loaded in the slide viewer.
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Figure 3.33: The Slide viewer also allows to host plugins in the right side panel

In order to properly navigate through your samples

• the origin of the stage (see 3.7.1)

• the geometry of the stage inserts

must be properly defined.

A stage insert is a mechanical holder for slides or multi-well-plates, which
simply snaps into the microscope motorized stage. These definitions are a
precondition for the use of the overview, see section 3.4.4 scan. For long
travel distance stages two inserts are supported.

The stage insert is divided in following regions:

• stage insert

• slides or microplates

• active regions, called wells

By moving the mouse over the stage insert, the current region (the stage insert
itself, a slide or a well) will be highlighted. That region can be selected via a left
mouse click. Selected regions will be displayed with a red border. The editor
button will now open the configuration panel of the selected region. For wells
a multi-selection is possible. The configuration of the regions is explained in
the following sections.

The full geometry configuration can be exported into a file by

File →Export
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Using

File →Import

the configuration can be reloaded into the stage geometry viewer.

3.6.1 Stage inserts

Figure 3.34: Slide viewer: Insert configuration panel. You can select different insert
types and shift the whole insert to adapt it to overview images.

In the configuration panel (Fig. 3.34) different types of slide inserts can be
selected:

• insert for three microscope slides, clamps on the right hand side

• insert for three microscope slides, clamps on the left hand side

• insert for four microscope slides

• insert for multiwell plates in SBS format

• insert for 88.5 mm petri dish

Second you get the option to shift the whole insert. This feature allows you
to precisely overlay a scanned overview image with the displayed slides. It is
recommended to first shift slide 1 to fit it’s stage insert position. If the overview
image of slide 1 does not exatly fit into the slide shift the insert as described in
chapter 3.6.4.
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Figure 3.35: Slide viewer: Slide configuration panel. You can select different slide
types and shift the whole slide to adapt it to it’s overview image.

3.6.2 Slides

Depending on the stage insert selected in section 3.6, the configuration panel
for slides (Fig. 3.35) offers a selection of different slide types. If your slide type
is not listed, you can define and configure a custom slide.

• MMI membrane slide

• MMI membrane slide, mounted roted by 180°

• 8 well slide

• 18 well slide

• MMI petri dish holder

• MMI single cap holder

• MMI double cap strip holder

• plain glass slide

• empty

Additionally you can shift the slide. This feature allows you to precisely overlay
a scanned overview image with the displayed slide. By the slide shifting pro-
cedure you can correct the geometry of your stage insert to precisely reflect
the hardware.
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If overview scan in slide 1 match the slide configuration, it is recom-
mended only to shift slide 2 and 3. It is acceptable that slide 2 and
slide 3 do not perfectly match the displayed stage insert positions.

If overview scans in slide 1 are shifted against the geomtetry dis-
played, first calibrate the stage origin, see section 3.7.1. If this is
not sufficient follow the procedure described in section 3.6.4

3.6.3 Active regions, wells

Figure 3.36: Slide viewer: Well configuration panel. You can select different well
rules and add descriptions to each well.

In the well configuration panel you can define following rules for each well:

• region for microdissection

• collection well for CellEctor

• deposit well for CellEctor

• rinse well for CellEctor

• unused well

Currently these rules are exclusively used by mmi CellEctor. Additionally you
can add own descriptions to each well.

3.6.4 Stage inserts first configuration

To adapt the insert position to the scanned overview images proceed as fol-
lows:
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Procedure

1. select a mounted insert in the insert configuration panel

2. select the mounted slides in the slide configuration panel

3. shift the first slide to it’s position in the stage insert, see section 3.6.2

4. calibrate the stage origion, see section 3.7.1

5. scan an overview image in slide 1, see 3.4.4 and adjust the image to the
slide position by shifting the whole insert. To get a precise positioning we
recomment to adjust the image of the left upper corner of an membrane
slide (Fig. 3.37) or the image of wells of an ampligrid to the displayed
slide.

6. press OK

7. adjust the other slides to their overview images, see section 3.6.2

This procedure only has to executed for a new stage insert. If the configuration
is properly set, a mismatch between the scanned image positions and the slide
configruations indicates a corrupt stage origin calibration. Recalibration of the
stage origin, see section 3.6.2, will be sufficient.

You are now ready to use slide navigation and scanning. The field-of-view
indicator and the dimensions of the slide overview will adapt during calibration.

Figure 3.37: Suggested positions on a mmi Membrane slide to precisely adjust the
stage insert position.

3.7 Calibration

3.7.1 Stage calibration

Under normal circumstances, the stage calibration remains valid unless the
stage is moved manually or using a software other than mmi CellTools.

If the software detects an invalid stage calibration, slide scanning will be dis-
abled and the overview scan will show a red warning sign.
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In this case or if the overview scans are shifted against a correct stage geom-
etry stage recalibration is required.

To recalibrate the stage start the calibration procedure by one of the following
options:

• press the Calibrate origin button in the Slide viewer.

• Setup →Calibrate Stage origin

• Ctrl + O in the main CellTools window.

During the calibration process the microscope objective will move down and
the stage will move to its limit switches. If the stage geometry is still not match-
ing a scanned overview image, the stage geometry configuration needs to be
adjusted, see sections 3.6.2 and 3.6.4.

3.7.2 Camera alignment

For the software to correctly overlay objects onto the camera image, and to
correctly measure distances, the exact width and height of the field of view in
millimeters must be known for each objective and optical setup. mmi CellTools
offers a fully automated calibration procedure that makes it easy to measure
these dimensions. The procedure also allows to minimize positioning errors
due to a tilted camera mount.

Camera alignment must be carried out independently for each
objective, as each objective has a differently sized field of
view.

To prepare automatic alignment, place an arbitrary sample on the microscope,
navigate to an area that yields an image of good contrast and focus. A slide
with printed text on its surface is also suitable as long as it can be optimally
focussed. Start alignment by selecting

Setup →Align camera with stage (Ctrl + A)

from the main menu.

If automatic alignment was successful, a dialog (see figure 3.38) displays the
results, which include:

• The measured width and height of the field of view,

• The relative standard error of the measured width and height, and
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Figure 3.38: Camera alignment results

• The measured inclination of the camera.

Ideally, camera inclination should be very close to zero (< 0.3◦). If it is larger,
eliminate camera tilt before proceeding (see section 3.7.2.1). The lower the
standard error of width and height, the more accurate positioning can be
achieved. The standard errors can be reduced through optimal focussing and
by viewing an area of high contrast at optimal illumination. (Also ensure that
microscope illumination is set up correctly.)

If satisfied with the results, click Accept to use the measured values. In some
cases, the automatic procedure does not yield an acceptable result and dis-
plays a failure message. In this case you may adjust lighting, view a different
area on the sample and Retry.

When finished, check that the stage exactly follows mouse movement when
using the Move stage tool. If not, repeat the procedure.

When working with a motorized microscope, mmi CellTools will ask whether
you would like to use the results for all objective items at this nosepiece posi-
tion. If you choose yes, the measured values will be used in all other setups
as well (see section 3.2).

3.7.2.1 Eliminating camera tilt

If the camera was unmounted or accidentally pushed out of its position, the
following procedure will help restoring the upright mounting position.

Procedure

1. Start automatic stage alignment as described above

2. If camera inclination is larger than 0.3◦, slightly loosen the camera’s
mounting screw using the supplied hex wrench, turn the camera by a
very small amount and retighten screw (lightly).

3. Repeat alignment until inclination is optimal
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4. Fully tighten mounting screw.

3.7.3 Lens offset calibration

Because of mechanical and optical tolerances two objectives never have ex-
actly the same optical axis. You see this effect by observing pixel shifts in
the video when you change an objective. The Paraxial Lens Offset function
is introduced to ensure that a marker points to the same object for different
objectives.

When you install a new objective into your microscope you have to calibrate
the Lens Offset. Over the time of operation it may be necessary to recalibrate,
when a shape is no longer fitting the same object by changing the objective.

Procedure

1. Please note the Lens offset calibration procedure should go from the
objective with highest magnification to the objective with the smallest
magnification. The standard order is:

(a) 40x to 20x

(b) 20x to 10x

(c) 10x to 4x

If your system is set up with other magnifications please select the order
of calibrations in the same manner.

2. Verify that the camera is aligned with the stage (movement follows mouse)
and mounted in an exactly upright position.

3. Mount a slide with a sample.

4. Select the start (higher magnification) objective and the corresponding
objective in the software

5. Move an easily noticeable object to the centre of the video screen.

6. Start the paraxial lens offset calibration with the menu item

Setup →Paraxial Lens Offset (Ctrl + O)

7. Draw a line around that object

8. Change the objective at the microscope and in the software

9. Move the shape exactly over the selected object
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You are now asked whether you would like to calibrate further objectives. If
you answer “yes” you are asked to repeat steps 8 and 9 for another objective.

Ensure that the shape is sufficiently large to start with. If at any point dur-
ing the calibration, the shape becomes too small to be moved accurately, you
may simply delete the shape and proceed with a new, larger shape. Alter-
natively, you may stop the calibration procedure at a mid-range objective and
later restart the calibration procedure, starting from that objective downwards.

You can cancel the calibration procedure with the Esc key.

3.8 Multi-user report

Users can get information about time spent using mmi CellTools for each Win-
dows user account.

Figure 3.39: Multi-user report

Select the menu item

Project →Usage report...

or start it from

Start →All Programs →mmi CellTools →mmi MultiUser Report

The time format is hhhh:mm:ss.
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3.9 Help

3.9.1 Help topics

The user manual can be opened directly inside the mmi CellTools software.
By pressing F1 on the keyboard the PDF file of the User Manual shows up.
You also launch the user manual by selecting the respective item in the Help
menu.

3.9.2 MMI online

If your PC is connected to the internet you can launch the MMI web page by
the menu item

Help →MMI online

Questions about the system can be sent to MMI service staff by the item

Help →Online Support

3.9.3 Version info

Information about the currently installed software version can be found under

Help →Version info
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4 mmi CellScan

The mmi CellScan offers the ability to scan and store microscope slides in full
resolution. The mmi CellScan is fully compatible with all other mmi products
and is designed with optimized speed, precision and data processing to allow
fast and reliable scans with huge amount of data.

The CellScan can be accessed by selecting the CellScan panel.

4.1 Getting started

4.1.1 Quick Start

4.1.1.1 System startup

To start mmi CellScan follow the steps below:

1. Start up the PC and allow the boot process to complete.

2. Turn on the microscope white light power supply.

3. Start mmi CellTools software and wait until the software has finished the
start up and self-test procedure.

Figure 4.1: The CellTools startup banner
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4.1.1.2 Calibration and Configuration

1. Calibrate Stage Origin by selecting menu item

Setup →Calibrate Stage Origin

or press Ctrl+O

2. Configure what type of Stage insert you are using

Setup →Configure Stage Insert

4.1.1.3 Manual Scanning

1. Switch to 4x objective and make an overview scan of your whole slide(s)
of interest.

2. Change to the objective you want to scan with

3. Focus on the object or structures you are interested in

4. Set Interpolation points by pressing F8. The number of Interpolation
points depends on your sample and the area you want to scan but is at
least three. They should cover all differences in focus planes.

5. Press Scan

4.1.1.4 System turn off

Shut down mmi CellTools by selecting the menu item

Project →Exit

or by clicking the main window’s close button.

Shut down the computer.

4.2 Slide scanning

To enable the creation and storage of full resolution scans check Create WSI’s
in the settings panel (Fig. 4.2). Every time a scan is started now (see sec-
tion 3.4.4), a full resolution image is automatically created and stored. The
recorded scans are saved as tagged image file format (TIFF) in the active
folder, which is displayed in the lower part of the settings frame. After the scan
is finished the image can be inspected using the slide viewer (see section 3.5).
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The slide viewer is updated with the most recent image by default. It is dis-
played at the position of the active slide.

Figure 4.2: The CellScan settings

If the option Stitching is checked CellScan will use an active stitching proce-
dure, so that no seems between the tiles will appear. The scanning speed can
be compromised using this option.

The scan of a full microscope slide with a 20x objective can have the size of
more than 40 GB. The output size can be decreased by selecting a compres-
sion option found in the left part of the settings view. You can choose between:

• None: the image is saved as raw data

• LZW: the image is compressed with Lempel–Ziv–Welch algorithm

• PackBits: the image is compressed with PackBits

Note: A compression unequal to None reduces the scanning speed
and its visualization in the slide viewer.

With any whole slide image created an additional XML-file will be save to the
same folder. This XML-filse stores the geometrical information of the slide
used for the slide scan.

4.3 Settings panel

With the mmi CellScan you can scan slides in all available imaging modes
and objectives. Simply select your desired settings and start the overview
scan. Additionially, if your microscope is equipped with fluorescence you can
perform scans in fluorescence mode (see section 3.2.1).

The speed of the mmi CellScan is mainly dependent following parameters:

• exposure time of the camera: the exposure time can be set in the cam-
era settings (see 3.3.2), with an longer exposure time the acquisition of
each frame increases, which leads to an elongated scan time
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• acceleration of the stage: the stage acceleration can be set in stage
settings (see 3.4.3), with a faster acceleration the stage movement in-
creases and reduces the total scan time

• activation of the enhanced image quality feature

• activation of image compression and compression mode

To ensure that the sample is in focus across the scanned area it is recomended
to set the focus map properly (see section 5.4.2). If the focus map is pre-
defined, the microscope changes its focus during scanning accordingly.

Note: Before using the CelScan make sure the camera is aligned
properly (see section 3.7.2)

In the mmi CellScan settings panel you can set the folder where your whole
slide images are saved.
Also you find a refresh button to reload the whole slide images in the selected
folder.

4.4 Explorer panel

Figure 4.3: The CellScan explorer

In the explorer panel (Fig. 4.3) you can see all recorded scans. Whenever a
scan is finished the explorer panel is updated.By pressing on the name of a
file in the explorer panel a preview is displayed in the preview panel below the
explorer panel (4.5). By holding the mouse over an image name the image
details are displayed. You also see three checkboxes for every whole slide
image, indicating

• time lapse: several timepoints are recorded
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• z Stack: several focus positions are recorded

• multi channel: several imaging modes are recorded

The images can be sorted by name or date by clicking on the corresponding
button.

4.5 Preview panel

Figure 4.4: The CellScan preview

An image that was selected in the explorer panel is displayed in the preview
frame Fig. 4.4. The corresponding file info can be shown by selecting Show
Fileinfo in the settings menu. To load a file in the slide viewer press the load
slide button with the desired slide number. By pressing the delete button the
selected slide image can be deleted.

If an appropriate xml-file containing shapes exists, it will be automatically
loaded with the whole slide image.

4.6 Cell types

Any object drawn will always be assigned to the highlighted cell type group
shown in the Cell types panel (Fig. 4.5).

In image analysis applications these cell type groups are com-
monly called classes. Anyway cell type groups or classes define
different cell types.
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.

All objects of the same cell type group are marked with the same contour color.
The number of groups is not limited.

The active cell type group is highlighted. To switch between groups, click on
the group of interest from the group list.

Figure 4.5: Cell type group selection.

The shapes of all cell type groups can be exported as xml–file. In return such
a file can be imported to replace the current groups and shapes.

4.6.1 Definition and editing of groups

To define a new cell type group press the Add button. To delete the selected
group press the Remove button.

In order to deal with groups invoke the Group editor (Fig. 4.6) using the edit
button.

Figure 4.6: Group editor

You can adjust the group name and drawing attributes (color and line thick-
ness) in the lower part of the editor.
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4.6.2 Regrouping shapes

To move individual shapes from one cell type group to another, open the con-
text menu (Fig. 3.26) by right-clicking on video panel and select the target
group from sub-menu (Move into group →GroupX ).

4.6.3 Group statistics

The statistics can be seen directly in the group panel (Fig. 4.5).

For each group, the list displays the number of shapes .

To export the statistics to a file, click Export Statistics. Data is saved as
character-separated values (CSV) file, which can be opened by most data
visualization and spread-sheet programs.

4.6.4 Shape list

If you click on the number of shapes in a group, a list with all shapes defined
in that group pops up (Fig. 4.7).

Figure 4.7: Shape list

The list displays the area in µm of each shape and an editable tick mark for all
shapes that will be processed with future actions.

To quickly deselect or select all shapes, use the checkbox at the bottom. By
holding down Shift multiple shapes can be selected or deselected.

By a double click with the left mouse button on the area field in the shape list
the stage is navigated to the selected shape.

The selected shape can be deleted by pressing the keyboard Del key.

To export the entire data sheet to a file, click Export. Data is saved as
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character-separated values (CSV) file, which can be opened by most data
visualization and spread-sheet programs.

4.7 5D-Scanning

CellScan offers you a variety of scanning options to get the best result for your
Slide-Scanning. Besides the option for automatic sample detection and auto-
focus mapping, you can scan your sample in 5 dimensions: XY-Scan of whole
slides, time-stacks, z-stacks and Multi-Fluorescence.

4.7.1 Automatic Sample Detection

When checking this option, CellScan will automatically scan for samples on
your slide and create an area of interest around them. This is particulary useful
if you want to reduce scanning time by not scanning the whole dish but only
the relevant parts that contain samples.

An automatic sample detection scan will use the selected preview channel
and the selected objective channel, see chapter 3.2.1 respectively 3.2.2. If
the required microscope parts are not motorized, CellTools will show a mes-
sage what you have to change. After the automatic sample detection Cell-
Tools will switch back to the previous channel and objective.

A separate sample detection scan can be triggered by a click on the sample
detection button.

Automatic sample detection starts with a camera autoexposure on
the start position. Make sure the slide positioning is well configured
to not start on an intransparent slide position resulting in a very
slow scan speed, see chapter 3.6.2.

4.7.2 Auto-focus Mapping

This option will automatically create a focus map (see 5.4.2) of your slides.
The sample on a microscope or membrane slide has a specified topographical
surface. To avoid permanent manual re-focussing, CellTools offers the ability
to specify a focus map that represents the surface of the sample.

A separate generation of the focus map of the active slide can be triggered by
a click on the create focus maps button.
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4.7.3 Multi-Slide Scanning

Normally CellScan will only scan the active Slide Position. With this option
checked it will scan all the selected slides at once.

4.7.4 Time-Stack

With the Time-Stack option you can perform multiple scans over a defined
time. With the drop-down menu next to the icon you can set the two main
parameters:

• Total Time: The overall time the scanning will take in minutes.

• Time Increment: The time between individual scans in minutes.

4.7.5 Z-Stack

The Z-Stack option will let you scan your samples in different focus planes.
With the drop-down menue next to the icon you can define the three main
parameters:

• z Min: The minimal position below the current focus position where the
the Z-Stack will start.

• z Step: The step-size between the single pictures.

• z Max: The maximal position above the current focus position where
your Z-Stack ends.

The CellScan will start at the z Min position and work upwards to the z Max
position.

4.7.6 Multi-Channels

With this option you can make multicolor image scans. The multi channels and
its pseudocolors can be selected in the Channel editor (see section 3.2.1). If
the option Stitching in Fig. 4.2 is checked, only one channel can be selected
as stitch channel in the channel editor. This stitch channel will be used for
stithing procedure, other selected multi channels will copy the stitching imfor-
mation, so that all seperate images have identical stitching result Fig. 4.8. You
should select the channel, which has best image signal for stitching, e.g. if
the sample has too low fluorescence signal in fluorescence channel, you can
stitch the multi-channel image as well by selecting the bright field channel as
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stitch channel. If the scan is finished the merged multi-channel image can be
displayed using the slide viewer (see section 3.5).

Figure 4.8: multi-channel image in full resolution with stitch
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5 Automated microscope control

mmi CellTools supports the following automated microscope types:

• Olympus IX-81

• Olympus IX-83

• Nikon TE2000 E

• Nikon Ti

• Nikon Ti2

The automated microscope control functionality must be installed by an autho-
rized MMI technician.

5.1 Activating microscope control

To enable automated microscope control, the microscope’s controller hub must
be connected to the PC (COM port, USB or IEEE1394 FireWire).

The Olympus IX-83 must not be connected to the same FireWire
interface as is used for the mmi CellCamera. When reconnect-
ing cables, observe the labels next to the computer’s interface
plugs, otherwise camera and/or microscope may cease to op-
erate correctly.

To make mmi CellTools connect to the microscope, activate the menu item

Microscope →Remote control

or by press CTRL + M.

This activates control of objectives, filter block, condenser cassette, fluores-
cence shutter and lamp brightness. The focus knobs on the microscope body
will still be useable.
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mmi CellTools will remember these settings and restore them at startup. Make
sure the microscope is connected and switched on before starting mmi Cell-
Tools.

5.2 Observation methods

The Channel editor is used to define the observation methods, see section 3.2.1.

In the Channel editor you define for each channel the position of the

• Filter block

• Condenser

• Optical path (Camera port, Binocular)

When you change the channel, the motorized microscope will set these three
items to the positions defined in the new channel automatically. The optical
path settings are specific to microscope vendors (see Table 5.1).

Table 5.1: Optical path settings for Olympus and Nikon microscopes

Olympus IX-83 Olympus IX-81 Nikon TI Nikon Ti2

Left side port 1 1 5 4

Binocular 3 2 1 1

Filter wheel position numbers and condenser turret position numbers are
clearly indicated on the microscopes.

A fast switch from any camera port to binocular and backwards is performed
in the menu

Microscope →Binocular

or by pressing F7 .

5.3 Objective control

In the objective editor, see section 3.2.2, you can save nosepiece position
number and the lamp voltage used.

When changing the objective the corresponding nosepiece position and lamp
voltage will be established automatically by the microscope. Nosepiece posi-
tion numbers are clearly indicated on the microscopes.
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The lamp voltage setting may be different for different objectives. Therefore
it is recommended to enable the per-objective camera white balance setting
(see section 3.3.2).

5.4 Z drive control

CellTools features built-in focusing aids and functions that rely on motorized z
drive control. These are:

• Sample surface definition

• Focus memory for pin positions

mmi CellTools offers three ways to manually focus the z drive:

1. Using the vertical slider on the right-hand side for coarse focussing;

2. Using the two arrow buttons at each end of the slider for fine focusing
and

3. Using the mouse wheel.

In order to use the mouse wheel for focusing, click the mouse wheel focus
button. While the button is activated, the mouse wheel is linked to the micro-
scope z-drive. To open the mouse wheel settings panel press Configure wheel
step in the menu of the mouse wheel button. The stepsize of the mouse wheel
can be set in the mouse wheel settings panel (Fig. 5.1).

Figure 5.1: Mouse wheel settings

It is possible to refocus using the microscope’s built-in focusing controls.

When using the manual focus wheel on the microscope, some
microscope models may not feedback the changed focus values
into the software. In order to notify CellTools that the focus has
changed, click on the numerical focus display below the slider to
update its value.
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5.4.1 Required calibrations

To estimate the correct focus position requires:

• Correctly measured location of the membrane slide in three dimensions
→ Sample plane definition

• Correctly measured z-drive offsets for

– different objectives

5.4.2 Sample focus map

The sample on a microscope or membrane slide has a specified topographical
surface. To avoid permanent manual re-focussing, CellTools offers the ability
to specify a focus map that represents the surface of the sample.

Figure 5.2: Sample surface with defined surface points

When moving to a different location on the slide, the focus is adjusted auto-
matically according to the sample surface definition.

Procedure

1. Focus the sample and define a surface point by pressing Add surface
interpolation point or F8

2. You can place as much surface points as you like but a minimum of 3
surface points is required

3. in general the more points are defined the better the surface is mapped

Note that the plane surface can be set with any objective but the
precision increases with magnification.
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Figure 5.3: Surface map user interface

After the focus map is defined, the sample focussing aid can be switched
on and off through the focus surface button or menu (Enable slide surface
focussing).

The focus map is stored independently for each slide. When chang-
ing to a slide, for which the focus map has not been defined, sur-
face focussing will be disabled.

You may use Reset slide surface to remove all points and start defining a
surface from scratch.

5.4.3 Z drive offset calibration for objectives

Each objective needs a different position of the Z drive. To calibrate the objec-
tives use the following procedure:

Procedure

1. Start with the objective with highest magnification

2. Focus microscope

3. Select another objective with closest magnification factor

4. Focus microscope

5. Select menu item

Setup →Parfocal Lens Offset
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6. go to step 3) until you calibrated all objectives.

After successful calibration the scope does not lose focus when you change
the objective.

5.4.4 Automatic Z drive control

Each time you move the stage with the arrow keys or mouse the best Z drive
position will be calculated and the Z drive motor moved to that position. With
flat samples you immediately receive a sharp image. The more uneven the
sample is, the more you need to correct the Z position manually.

If you draw a shape or if you set a pin position the software saves the z position.
Each time you go back to the shape or the pin position, the saved Z position
will be recalled. You never need to refocus during cutting.

5.5 Microscope safety parameters

mmi CellTools provides functions to help prevent physical damage to the mi-
croscope objectives. These functions are always in place and do not require
manual intervention. However, under certain circumstances, they can be con-
figured through the safety parameters dialog.

Figure 5.4: Microscope safety parameters

Open the dialog using the menu item

Microscope →Safety parameters. . .
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5.5.1 Objective collision prevention

There are two situations in which mmi CellTools automatically lowers the ob-
jective turret to prevent potential damage to the objectives:

The first situation is when switching to another objective. This function is car-
ried out automatically and does not require configuration.

The second situation is when moving the stage to a different slide. If the two
slides are not perfectly aligned the surface of the objective may scratch against
the slide’s lower surface. To reduce the risk of damage, the objective turret is
lowered by a certain amount, which can be specified in the safety parameters
dialog (Slide-to-slide motion). If the slides used in your setup exhibit very high
tolerances you may wish to increase this value.

When you are using the small step arrow keys or the mouse the z drive escape
function is switched off.

5.5.2 Objective-sample collision

To prevent contact between the objectives and the specimen and to protect
the microscope itself, the range of the focus drive is automatically limited to
a certain maximum value, which can be specified in the safety parameters
dialog.

To use the current focus setting as objective-sample collision limit, press the
Read current button. To reset the limit to its default value, press Reset.

The recommended procedure for setting the objective-sample collision limit is:

Procedure

1. Select the objective with the shortest working distance (normally the ob-
jective with the highest magnification)

2. Focus the microscope

3. Open the safety parameters dialog:

Microscope →Safety parameters. . .

4. Press the Read current button

5. Add the working distance in µm to the displayed value and go to step 8,
or if the working distance is unknown proceed with step 6.

6. Carefully move the objective as close as possible to the specimen with-
out touching it.
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7. Write down the value displayed under Objective-sample collision.

8. Press the Read current button again.

9. Now enter an Objective-sample collision limit half-way between the two
positions.

10. Click OK

5.6 Fluorescence shutter control

If installed, the microscope’s epifluorescence shutter can be opened and
closed via software. Select

Microscope →Shutter

or press F6.
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6 Maintenance

6.1 System check

• Verify the correct operation of the LEDs by simulating their functions.

6.2 Cleaning

Caution

• Before cleaning the system, disconnect all system components from the
mains.

• Before connecting all system components to the mains again, ensure
that all positions in the objective turret that do not contain an objective
lens are covered with blanks.

6.2.1 Microscope

For further details, see microscope manual.

6.2.2 Cleaning optical parts

• Clean all easily accessible optical parts once a week

• Carefully wipe the optical parts with a cleaning tissue moistened with
alcohol of 70% to 80%

6.2.3 Cleaning when actually dirty

Actual dirt, e.g. caused by fingerprints or immersion oil, must be removed
immediately or the optical functions will be permanently impaired. Dirt that
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has been burnt onto the surface of lenses or filters by laser light can no longer
be removed.

• Lightly moisten a cleaning tissue with pure alcohol (70-80%) or spirit and
wipe the dirty parts very carefully

• Clean dry objectives and oculars gently with a cotton bud or a cotton
wool wrapped around a toothpick; Only use surgical cotton from the
pharmacy

• Remove cotton lint and fluff by blowing, e.g. with an enema syringe

Caution

• Moisten cleaning tissue only slightly, do not soak; Excessive solvent
might dissolve the cement of the lenses

• Do not use acetone for cleaning under any circumstances

6.3 Trouble shooting

This section provides support for problems that can occur when working with
the mmi CellTools. Most of the problems can easily be solved by the user.

6.3.1 View

No image on the monitor

• The microscope camera port switch should be set towards the camera
(default is left side port)

• The camera exposure time is much too low

• The camera cables are not connected properly

The image is not clear, too dark, too bright

• check the camera setup

• Check that there is sufficient illumination from the white light and that the
light path is not obstructed

• Check that the correction ring of the objective is on the value 1 (corre-
sponding to glass thickness)
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• Use the diffuser for improved image quality

• Calibrate the camera in the z-axis

The colors are wrong

• Set white balance

• A fluorescence filter is still turned into the light path

6.3.2 Movement

The stage moves a large distance very fast when using the mouse, or stage
movement does not follow mouse.

• Wrong objective selected

• Camera alignment not correct (see section 3.7.2)

• The camera is not mounted in an exactly upright position

Live image does not follow the hand, if moving stage with the mouse:

• Wrong objective selected

• Camera alignment not correct (see section 3.7.2)

• The camera is not mounted in an exactly upright position

Image not in focus after objective is changed (for automated microscope only)

• Parfocal lens offset not correct.

Displacement of markers after objective is changed:

• Paraxial lens offset not correct.

Overview images not matching stage geometry.

• Stage geometry not properly defined, see section 3.6

• Stage origin calibration invalid, see section 3.7.1
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6.3.3 Overview

The stitched image is patchy. Tiles do not match correctly.

• Camera alignment not correct (see section 3.7.2)

• The camera is not mounted in an exactly upright position
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A List of Keyboard Shortcuts

General

+ Move to next shape . . . . . . . . . . . . . . . . . 22, 30

- Move to previous shape . . . . . . . . . . . . . . 22, 31

Alt + C circle tool . . . . . . . . . . . . . . . . . . . . . . . . . 26

Alt + Del delete shape tool . . . . . . . . . . . . . . . . . . . . 27

Alt + E ellipse tool . . . . . . . . . . . . . . . . . . . . . . . . 26

Alt + F freehand tool . . . . . . . . . . . . . . . . . . . . . . . 25

Alt + L line tool . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Alt + M Measure distance . . . . . . . . . . . . . . . . . . . . 31

Alt + Q rectangle tool . . . . . . . . . . . . . . . . . . . . . . 27

Alt + R select and move tool . . . . . . . . . . . . . . . . . . 25

Arrow down Move small step down . . . . . . . . . . . . . . . . . 31

Arrow left Move small step left . . . . . . . . . . . . . . . . . . . 31

Arrow right Move small step right . . . . . . . . . . . . . . . . . . 31

Arrow up Move small step up . . . . . . . . . . . . . . . . . . . 31

Caps Lock Suppress continous stage movement . . . . . . . . . 18

Ctrl + A Align Camera . . . . . . . . . . . . . . . . . . . . . . 40

Ctrl + C Copy shape . . . . . . . . . . . . . . . . . . . . . . . 28

Ctrl + Del Delete all shapes . . . . . . . . . . . . . . . . . . . . 27

Ctrl + H Hide shape indices . . . . . . . . . . . . . . . . . . . 29

Ctrl + I Show stage insert . . . . . . . . . . . . . . . . . . . . 23

Ctrl + O Set stage origin . . . . . . . . . . . . . . . . . . . 40, 42

Ctrl + P Stage movement settings . . . . . . . . . . . . . . . 18
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Ctrl + Shift + Del Delete all shapes from current group . . . . . . . . . 27

Ctrl + V Paste shape . . . . . . . . . . . . . . . . . . . . . . . 28

Del Delete shape . . . . . . . . . . . . . . . . . . . . . . . 27

End Move to last shape . . . . . . . . . . . . . . . . . 22, 30

Esc Interrupt current process . . . . . . . . . . . . . . 20, 43

F1 Display user manual . . . . . . . . . . . . . . . . . . 44

Home Move to first shape . . . . . . . . . . . . . . . . . 22, 30

Numpad: Down Move large step down . . . . . . . . . . . . . . . . . 31

Numpad: Left Move large step left . . . . . . . . . . . . . . . . . . . 31

Numpad: Right Move large step right . . . . . . . . . . . . . . . . . . 31

Numpad: Up Move large step up . . . . . . . . . . . . . . . . . . . 31

Space Toggle between moving and drawing mode . . . 17, 24

Camera control

Ctrl + Alt + C Copy image . . . . . . . . . . . . . . . . . . . . . . . 14

Ctrl + R Open camera settings . . . . . . . . . . . . . . . . . 11

Ctrl + S Save an image . . . . . . . . . . . . . . . . . . . . . . 13

Shift + M multi channel image . . . . . . . . . . . . . . . . . . . 16

Microscope control

Ctrl + F autofocus . . . . . . . . . . . . . . . . . . . . . . . . . 17

CTRL + M Remote control On/Off . . . . . . . . . . . . . . . . . 55

F6 Open/close fluorescence shutter . . . . . . . . . . . 62

F7 Switch between camera and binocular . . . . . . . . 56

F8 add surface point . . . . . . . . . . . . . . . . . . . . 58
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B Technical data

B.1 Required minimum workspace

The table top for the microscope, laser, optical equipment, computer monitor
and keyboard requires a minimum workspace of 1.20 m × 0.90 m.

The computer should be positioned under or near the table. The camera–
computer connection cable is 2 m long to ensure reliable data transfer.

B.2 System components

B.2.1 Microscope

Inverted or upright research microscope.

Supported microscope models:

• Olympus IX-71/81
• Olympus IX-53/73/83
• Nikon Ti (S, U, E)
• Nikon Ni (U, E)
• Nikon TE 2000 (S, U, E)
• Nikon Ti2 (U,E)
• External z-Drive motorisations for different manual inverted microscopes
• Nikon TS2R

B.2.2 Stage

Standard stage

Scanning stage with stepper motors.
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Scanning area: 120 × 100 mm2

Repositioning accuracy: < 1 µm

Step resolution: 0.156 µm

Speed: 50 mm/sec

Long travel scanning stage for two inserts

Long travel scanning stage with stepper motors.

Scanning area: 280 × 82 mm2

Repositioning accuracy: < 1 µm

Step resolution: 0.075 µm

Speed: 25 mm/sec

B.2.3 Digital camera

mmi CellCamera VCXU23c

• Chip type: Sony IMX174
• 1 /1.2“ progressive scan CMOS
• Native Resolution 1920 x 1 200 pixels
• Pixel Size 5.86 µmx 5.86 µm
• Dynamic Range 72 dB
• USB3 interface
• >45 fps, full resolution, live view, best color calculations

mmi CellCamera VCXU50m

• Chip type: Sony IMX174
• 2/3“ progressive scan CMOS
• Native Resolution 2448 x 2048 pixels
• Pixel Size 3.45 µmx 3.45 µm
• USB3 interface
• >50 fps, full resolution, live view, best color calculations

mmi CellCamera MXF285c

• IEEE1394b (FireWire) color CCD camera
• 2/3" interline transfer frame readout CCD
• Temperature controlled active Peltier cooling
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• signal to noise ratio: > 62 dB
• On board integrated color processor for high quality color calculation
• 1392 × 1040 pixels with up to 20fps
• Ultra high sensitivity

mmi CellCamera DXA285cF

• IEEE1394a (FireWire) interline transfer color CCD camera
• 2/3" interline transfer frame readout CCD
• Super HAD technology
• signal to noise ratio: > 56 dB
• 1392 × 1040 pixels with up to 15 fps
• Ultra high sensitivity

mmi CellCamera DXA285F

• IEEE1394a (FireWire) interline transfer CCD camera
• 2/3" interline transfer frame readout CCD
• Super HAD technology
• 1392 × 1040 pixels with up to 15 fps
• Ultra high sensitivity

Hamamatsu Orca Flash4.0 V3

• Digital CMOS camera with sCMOS sensor designed for scientific re-
search use.

• quantum efficiency 82% @ 560 nm
• dynamic range 36000:1
• TE Cooling to −10°C

Hamamatsu Fusion BT

• Digital CMOS camera with sCMOS sensor designed for scientific re-
search use.

• quantum efficiency 95% @ 550 nm
• dynamic range 21400 :1
• 2304 × 2304 pixels with up to 89.1fps
• Air-Cooling to −8°C
• Water-Cooling to −15°C
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B.2.3.1 Andor iXonEM+ EMCCD Camera 897

• EMCCD Technology: Even single photon signals are amplified above the
noise floor. Full QE of CCD chip is harnessed (no intensifier).

• RealGainTM: Absolute EMCCD gain selectable directly from a linear and
quantitative scale.

• TE Cooling to −100°C: Critical for elimination of dark current detection
limit.

B.2.4 Fluorescence Light sources

B.2.4.1 Lumencor Spectra III

• Sources: 8 solid state sources including LEDs, lasers and proprietary
luminescent light pipes

• Wavelengths: 380 - 750 nm

• Bandpass Filters: Integrally installed bandpass filters for spectral output
refinement

• Output Power5̃00mW per color band ± 10

B.2.5 Computer

Suitable computer workstation models are preselected and tested by MMI.
Only use computer hardware supplied through MMI. Before performing hard-
ware modifications, contact service.

mmi CellTools supports Microsoft Windows10, 64bit.
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C Service

Service should only be performed by qualified MMI personnel or our desig-
nated representative(s). The MMI system contains no user-serviceable parts.

It is strongly recommended to execute an annual system service to maintain
the system performance.

For questions about your instrument (technical, consumables, warranties)
please contact:

Head office Germany:
B Molecular Machines & Industries GmbH (MMI)

Breslauer Strasse 2
85386 Eching
Germany

T +49 – (0)89 319 048 40
u +49 – (0)89 319 048 59

Switzerland:
B MMI Molecular Machines & Industries AG

Flughofstrasse 37
8152 Glattbrugg
Switzerland

T +41 – 44 522 19 36

North America:
B MMI Molecular Machines & Industries Inc.

P.O. Box 348
Haslett, MI 48840
USA

T +1 – 331 307 0273
u +1 – (321) 978 0304
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m www.molecular–machines.com

k service@molecular–machines.com
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